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ABSTRACT 

Background: Vernonia amygdalina Del. Isaplant from the Asteraceae family is a small shrub 

with dark green leaves and leathery bark that grows predominantly in Africa. This plant 

contains steroidgly cosides, such: as Vernodalin, Vernolide, Vernolepin, Vernomenin, 

Vernomydin, Vernodalol, Hydroxylvernolide,11,13-dihydroxylvernodalin, 4,15-

dihydrovernodalin, 1,2,3,15,11,13,2’,3’, hexahydrovernodalin, dan 1,2,3,15,11,13,2’,3’-

octahydro vernodalin. Sesquiterpene Lakton in African leaves (Vernonia amygdalina) have 

properties, among others, as antimicrobials. Objective:  The purpose of this study was to 

determine the inhibition of the SARS-CoV-26LU7 protease enzyme by Sesquiterpen Lakton 

compounds from African leaves using the in-silico tethering method. Method: The in-

silicomooring process is carried out using the PLANTS program and visualized using the 

MOE 2008 program. The protease enzyme was downloaded through the Protein Data Bank 

(PDB) with code 6LU7. Two-and three-dimensional models were generated using the Marvin 

Sketch program. The resulting docking value is evaluated as a result of the docking process. 

Results: The results showed that the protease 6LU7 enzyme tethering of the SARS-CoV-2 

virus could provide valid results in-silico. The Sesquiterpen Lakton compounds from Afri can 

leaves can inhibit the protease enzyme. The docking result is a bletovisualize of the binding 

amino acids. Conclusion: In this study, it can be concluded that the Sesquiterpen Lakton 

compounds from African leaves can inhibit the SARS-CoV-2 virus 6LU7 protease enzyme 

with a docking score close to the docking score of each comparator drug.  

 

Keywords: Antimicrobial, docking, 6LU7, in silicon, Vernonia amygdalina Del. 

 

PENDAHULUAN 

Diawal tahun 2020, dunia digemparkan 

dengan merebaknya virus baru yaitu corona 

virus jenis baru (SARS-CoV-2) dan 

penyakitnya disebut corona virus 2019 

(COVID-19). Diketahui, asal mula virus ini 

berasal dari Wuhan, Tiongkok. Ditemukan 

pada akhir desember tahun 2019. Sampai saat 

ini sudah dipastikan terdapat 65 negara yang 

telah terjangkit virus satu ini (DataWHO) 

(PDPI, 2020). Pada awalnya data 

epidemiologi menunjukkan 66% pasien 

berkaitan atau terpajan dengan satu pasar 

seafood atau live market di Wuhan, Provinsi 

Hubei Tiongkok. Sampel isolat dari pasien 

diteliti dengan hasil menunjukkan adanya 

infeksi coronavirus, jenis betacoronavirus tipe 

baru, diberi nama 2019 novel 

Coronavirus (2019-CoV-2). Pada 

tanggal 11 februari 2020 World Health 

Organization memberi nama virus baru 

tersebut Severe Acute Respiratory 

Syndrome Coronavirus-2 (SARS-CoV-

2) dan nama penyakitnya sebagai 

Coronavirus disease 2019 (COVID-19) 

(WHO,2020). Corona virus bukanlah 

merupakan kejadian yang pertama kali. 

Tahun 2020 

SevereAcuteRespiratorySyndrome 

(SARS) disebabkan oleh SARS-

coronavirus (SARS-CoV) dan penyakit 

Middle East Respiratory Syndrome 

(MERS) tahun 2012 disebabkan oleh 

MERS-Coronavirus (MERS-Cov) 
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dengan total akumulatif kasus sekitar 10.000 

(1000-an kasus MERS dan 8000-an kasus 

SARS). Moralitas akibat SARS sekitar 10% 

sedangkan MERS lebih tinggi yaitu sekitar 

40% (Wang Z,2020). SARS-CoV-2 adalah 

virus yang sangat terdifusi, menyebar melalui 

titik-titik, kontak langsung dan kontak dengan 

objek yang terinfeksi, yang waktu 

inkubasinya adalah 1-14 hari dan berkurang 

juga oleh orang yang terinfeksi dengan gejala 

medis (Lai CC dkk,2019; Perella A,2019; 

Zhang W,2020). Kebanyakan orang yang 

terinfeksi hanya menunjukkan gejala 

pernafasan ringan, atau tidak sama sekali. 

Hanya 5-10% dari orang-orang yang tertular 

yang memperlihatkan syndrome pernafasan 

yang parah yang lengkap yang disebut 

Coronavirus disease (COVID)-19 (Yang X, 

dkk 2020). Selain itu, kematian covid-19 

adalah 0,2% pada individu muda yang sehat, 

sementara itu tumbuh pada usia dan 

kegelisahan, menjadi yang tertinggi dalam 

diri orang-orang yang berusia di atas 80 tahun 

dengan penyakit jantung yang sudah ada The 

Novel C,2020). Untuk menempatkan segala 

sesuatu dalam perspektif, SARS-CoV 

memiliki kefanaan sekitar 10% dan MERS-

CoV memiliki kefanaan sekitar 35% (Arabi 

YM., dkk 2014, WHO,2002). Corona virus 

memiliki family besar yang menyebabkan 

penyakit pada manusia dan hewan. Pada 

manusia dapat menyebabkan penyakit dengan 

gejala mulai dari Common Cold sampai 

Severe Acute Respiratory Syndrome (SARS) 

(Global A and Tesponse (GAR),2013). Baru-

baru ini virus MERS-CoV ditemukan secara 

ge netik terkait dengan virus yang 

diidentifikasi pada kelelawar dari Afrika 

Selatan. Tetapi tidak ditemukan adanya bukti 

definitive bahwa MERS-CoV berasal dari 

kelelawar (Smith dkk 2013). Demikian pula 

sampai saat ini belum diketahui bagaimana 

virus MERS-CoV dapat bertahan dalam 

lingkungan (Global A and Response 

(GAR),2013). COVID-19 termasuk dalam 

genus dengan flor elliptic dan sering 

berbentuk pleomorfik, dan berdiameter 60-

140 nm. Virus ini secara genetik sangat 

berbeda dari virus SARS –CoV dan MERS-

CoV. Penelitian saat ini menunjukkan bahwa 

homologi antara COVID-19 dan 

memiliki karakteristik DNA 

coronavirus pada kelelawar SARS yaitu 

dengan kemiripan lebih dari 85%. 

Ketika dikultur pada vitro, COVID-19 

dapat ditemukan dalam sel epitel 

pernafasan manusia setelah 96 jam. 

Sementara itu untuk mengisolasi dan 

mengukur vero E6 dan Huh-7 garis sel 

dibutuhkan waktu sekitar 6 hari. Paru-

paru adalah organ yang paling 

terpengaruh oleh COVID-19, karena 

virus mengakses sel inang melalui 

enzim ACE2, yang paling melimpah di 

sel alveolar tipe II paru-paru. Virus ini 

menggunakan glikoprotein permukaan 

khusus, yang disebut “spike”, untuk 

terhubung ke ACE2 dan memasuki sel 

inang (Letko M, 2020). Kepadatan 

ACE2 disetiap jaringan berkorelasi 

dengan tingkat keparahan penyakit 

dijaringan itu dan beberapa ahli 

berpendapat bahwa penurunan aktivitas 

ACE2 mungkin bersifat protektif. Dan 

seiring perkembangan penyakit 

alveolar, kegagalan pernafasan mungkin 

terjadi dan kematian mungkin terjadi 

(Xu H,2020). Pada mulanya 

transmisivirus ini belum dapat 

ditentukan apakah dapat melalui antara 

manusia-manusia. Jumlah kasus terus 

bertambah seiring dengan waktu. Selain 

itu, terdapat kasus 15 petugas medis 

terinfeksi oleh salah satu pasien. Salah 

satu pasien tersebut dicurigai kasus 

“super spreader” (Channel News Asia, 

2020). Akhirnya dikonfirmasi bahwa 

transmisi pneumonia ini dapat menular 

dari manusia ke manusia (Relman, 

2020). Sampai saat ini virus ini dengan 

cepat menyebar masih misterius dan 

penelitian masih terus berlanjut. Saat ini 

ada sebanyak 65 negara terinfeksi virus 

corona. Menurut data WHO per tanggal 

2 maret 2020 jumlah penderita 90.308 

terinfeksi Covid-19. Di Indonesia pun 

sampai saat ini terinfeksi 2orang. Angka 

kematian mencapai 3.087 atau 2.3% 

dengan angka kesembuhan 45.726 

orang. Terbukti pasien konfirmasi 
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Covid-19 di Indonesia berawal dari suatu 

acara di Jakarta dimana penderita kontak 

dengan seorang warga Negara asing (WNA) 

asal Jepang yang tinggal di Malaysia. Setelah 

pertemuan tersebut penderita mengeluhkan 

demam, batuk dan sesak nafas (WHO,2020). 

Saat ini belum tersedia rekomendasi tata 

laksana khusus pasien COVID-19, termasuk 

antivirus atau vaksin. Tata laksana yang dapat 

dilakukan adalah terapi simtomatik dan 

oksigen. Pada pasien gagal napas dapat 

dilakukan ventilasi mekanik. National Health 

Commision (NHC) China telah meneliti 

beberapa obat yang berpotensi mengatasi 

infeksi SARS-CoV-2, antara lain interferon 

alfa (IFN-α), lopimapir/ritonavir (LPV/r), 

ribavirin (RBV), klorokuin fosfat (CLQ/CQ), 

remdesvir dan umifenovir dan umifenovir 

(arbidol) (Cascella, M., et al,2020). Selain itu, 

juga terdapat beberapa obat antivirus lainnya 

yang sedang dalam uji coba di tempat lain. 

Biarpun belum ada obat yang terbukti 

meyakinkan efektif melalui uji klinis, China 

telah membuat rekomendasi obat untuk 

penanganan COVID-19 dan pemberian tidak 

lebih dari 10 hari (Dong L, et al, 2020). 

Dalam perang melawan corona virus para 

ilmuwan telah menemukan tiga strategi untuk 

mengembangkan obat baru. Strategi pertama 

adalah untuk menguji anti-virus spektrum 

luas yang ada. Interferon, ribavirin, dan 

penghambat siklofilin yang digunakan untuk 

mengobati pneumonia corona virus jatuh 

dalam kategori ini. Keuntungan dari terapi ini 

adalah bahwa mereka mengetahui 

karakteristik metabolisme, dosis yang 

digunakan, potensi kemanjuran dan efek 

samping yang jelas karena telah disetujui 

untuk mengobati virus infeksi. Tetapi 

kerugiannya adalah terapi ini memiliki 

spektrum yang luas dan tidak dapat 

membunuh langsung target coronavirus dan 

efek sampingnya tidak boleh diremehkan. 

Strategi kedua adalah menggunakan database 

molekuler yang ada untuk menyaring molekul 

yang mungkin memiliki efek terapeutik pada 

coronavirus (de Wilde, AH., et al, 2014). 

Strategi ini memungkinkan untuk mengetahui 

banyaknya fungsi suatu molekul obat 

misalnya, penemuan obat infeksi HIV: 

lopinavir/ritonavir. Strategi ketiga 

secara langsung didasarkan pada 

informasi genom dan karakteristik 

patologis yang berbeda dari corona 

virus untuk mengembangkan obat baru 

yang ditargetkan dari awal. Secara 

teoritis, obat-obat yang ditemukan 

melalui terapi ini akan menunjukkan 

efek anti-coronavirus yang lebih baik, 

tetapi prosedur penelitian obat baru 

mungkin memakan waktu beberapa 

tahun, atau bahkan lebih dari 10 tahun 

(Omrani, AS., et al,2014). Sebuah 

konsorsium universitas cina telah 

menjelaskan struktur 3Ddari protease 

SARS CoV-2 sehingga akan menjadi 

titik awal dalam sebuah penelitian (Liu 

X et al.,2020). Protease utama dari 

SARS-CoV (Z. Xu et al; A 

Zhavoronkov et al.,2020). SARS CoV-2 

adalah virus RNA beralasan positif, 

indera tunggal yang menampilkan 

genom RNA virus terbesar. Genom 

virus SARS CoV-2 terdiri dari 30.000 

nukleotida, yang gen replikasinya 

mengkode dua poliprotein yang 

tumpang tindih yaitu pp1a dan pp1ab, 

yang diperlukan untuk replikasi dan 

transkripsi virus (Zhou P et al; Wu F et 

al,2020).  

 

METODE PENELITIAN 

Penelitian ini merupakan penelitian 

Desktiptif untuk menguji aktivitas 

senyawa Sesquiterpen Laktondari daun 

afrika (Vernonia amygdalina Del.) 

terhadap penghambatan enzim protease 

6LU7 Virus SARS-CoV-2. Tahap 

dalam penelitian ini meliputi: 

Download dan instal asiaplikasi yang 

dibutuhkan (Plants, Cmd, Mingwm10, 

Pc_4pyp, Notepad, Marvin Sketch, 

Yasaradan Moe 2008), Dan validasi 

metode penambatan secara insilico 

terhadap enzim protease 6LU7 Virus 

SARSCoV-2, Serta penambatan 

molekul senyawa Sesquiterpen Lakton 

dari daun afrika (Vernonia amygdalina 

Del.) terhadap enzim protease 6LU7 

Virus SARS CoV-2 secara insilico. 
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Alat dan Bahan Penelitian 

Alat-alat yang digunakan dalam penelitian ini 

adalah laptop acer aspireseries (E1-470) yang 

dioperasikan dengan sistem Windows7, 

prosesor Intel
® 

Core
™ 

i3-3217U, kecepatan 

prosesor 1, 80GHz, kapasitas hard disk drive 

500GB, dan kapasitas RAM memory 4Gb 

serta operasi systembit-64 yang dilengkapi 

dengan program Plants, Cmd, Mingwm10, 

Pc_4pyp dan Note ped digunakan sebagai alat 

untuk menjalankan proses penambatan In 

Silico, program Marvin Sketch digunakan 

untuk menghasilkan model Dua Dimensi (2D) 

dan konfigurasi Tiga Dimensi (3D) dari 

molekul Kimia, Program Yasara digunakan 

sebagai media untuk memvisualisasikan hasil 

Docking secara In Silico. Model struktur Tiga 

Dimensi (3D) yang digunakan dalam 

penelitian ini adalah enzim protease dengan 

kode Protein Data Bank (PDB) adalah 6LU7 

yang diambil dari situs web 

http://www.rcsb.org/structure/6LU7. 

 

Proses Mendapatkan Senyawa 

Seskuiterpen Lakton dari Daun 

Afrika (Vernonia amygdalina) 

Senyawa seskui terpenlakton dari daun 

afrika (Vernonia amygdalina) yang 

terdiri dari vernodalin; vernolide; 

hydroxy vernolide; vernodalol; 

vernolepin; vernomenin; 4,15–

dihydrovernodalin; 1,2,2’,3’-

tetrahydrovernodalin; 1,2,11,13,2’,3’-

hexahydrovernodalin; 

1,2,3,15,11,13,2’,3’-

octahydrovernodalin; 11,13-

dihydrovernodalin; dan vernomygdin. 

Senyawa tersebut kemudian 

digambarkan bagian-bagian molekulnya 

menggunakan program Marvin Sketch. 

Marvin Sketch adalah software kimia 

yang ditujukan untuk menggambar 

struktur molekul, reaksi kimia, dan lain-

lain. Dalam hal ini, Marvin Sketch 

digunakan sebagai media untuk 

menghasilkan model dua dimensi (2D) 

dan konformasi tiga dimensi (3D) dari 

molekul senyawa uji Seskuiterpen 

Lakton dan senyawa pembanding.

 

Tabel 1 menunjukkan struktur senyawa Sesqui terpenlakton dari Daun Afrika (Vernonia 

amigdalina Del). 
No Senyawa Molekuler Rumus 

Molekul 

Struktur molekul Berat 

Molekul 

1 Vernodalin 
C19H20O7 

 

360.12 

2. Vernolide 

 

 

 

C19H25O7 

 

365.40 

3 Vernolepin 
C15H16O5 

 276.29 
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4 Vernomenin 
C15H16O5 

 

276.29 

5 Vernomygdin 
C21H32O7 

 

396.48 

6 Vernodalol 
C20H26O9 

 

410.42 

7 Hydroxylvernolide 
C20H29O7 

 

397.44 

8 11,13-

dihydroxyvernodalin C20H22O7 

 

374.39 
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9 4,15-dihydrovernodalin 
C19H22O7 

 
 

362.38 

10 1,2,2’,3’-

tetrahydrovernodalin C19H24O7 

 

364.39 

11 1,2,3,15,11,13,2’,3’-

hexahydroverdalin C19H26O7 

 

366.41 

12 1,2,3,15,11,13,2’,3’-

octahydrovernodalin C19H28O7 

 

368.43 

Validasi metode penambatan insilico 

terhadap Enzim protease 6LU7 

Preparasi Protein 

Pemodelan homologi dilakukan dengan 

menggunakan program Yasara. Pastefile dari 

6LU7 (didownload dari situs web 

http://www.rcsb.org/structure/6LU7), 

kemudianload PDB6LU7 ke file Yasara. 

Hapus bagian dari sistem yang tidak 

diperlukan dalam protokol docking (yang 

diperlukan hanya satu protein, termasuk air 

jika essensial, dan satu ligan). Hapus OH 2  
yang berada disistem (Edit> delete> water> 

OK). Tambahkan hidrogen kedalam sistem 

dengan bantuan Yasara, sebab resolusi 

struktur kristal tidak mampu memprediksi 

keberadaan hidrogen (Edit> Add> 

Hydrogensto: All). Simpan file sebagai 

Yasara Object (File> Save as> Yasara 

Object), simpan sebagai 6LU7.yob. 

Hapus ligan asli sehingga hanya 

menyisakan protein target saja dengan 

pocket untuk docking (Edit> Delete> 

Residue); pilih sequen PRD_002214, 

Name PRD_002214, Belong stoor ALL, 

klik “OK”, simpan sebagai protein. 

mol2. Kordinat pocket dapat diketahui 

dengan merujuk pada koordinat ligan 

tiga Dimensi (3D) asli. Untuk itu hanya 

diperlukan file yang berekstensi. mol2 

yang hanya berisi ligan asli (Purnomo, 

2013). 
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Preparasiref_ligand 

Setelah dilakukan pemodelan homologi 

dengan menggunakan program Yasara, load 

file Yasara Object dari 6LU7. yob. 

Selanjutnya, hapus protein yang ada kecuali 

pDR_002214 (Edit> Delete> Residue) pilih 

Name pDR_02214, Belong stoorhas ALL, 

aktifkan opsi “Negate Name” dan klik “OK”. 

Simpan sebagai ref_ligand.mol2 (Purnomo, 

2013). 

 

Prepara siligan 

Molekul ligan asli dibuat model dua dimensi 

dan konformasi tiga dimensinya dengan 

bantuan program Marvin Sketch (File> 

Open...ref_ligand.mol2), structure> 

Clean2D> Cleanin2D. Cek protonasidipH7, 

4(Tools> Protonation> Major Microspecies> 

Klik Ok dijendela yang baru terbuka). Klik 

kanan dijendela yang memunculkan major 

species, Pilih Save as kemudian simpan 

sebagai Ligand_2D. Tutup jendela Marvin 

sketch, lalu buka yang baru. File> Open... 

Ligand 2D.mrv. Pencarian konformasi 

(Tools>Conformation>Conformers> Klik 

Ok). Simpan hasil sebagai Ligand.mol2 

(Purnomo, 2013). 

 

Proses Penambatan In Siliko 

Konformasi tiga dimensi dari molekul ligan 

asli pDR_002214 ditambatkan kedalam 

molekul kantung ikatan asalnya, yaitu enzim 

protease 6LU7 dengan bantuan program 

PLANTS, sehingga diperoleh Dockingscore 

dari masing-masing konformasi. Konformasi 

yang memberikan Dockingscore terendah 

dikopikan ke C:/docking_plants (Purnomo, 

2013). 

 

Validasi Metode Penambatan In Siliko 

pada Enzim Protease 6LU7 

Konformasi yang memberikan nilai energi 

ikatan yang terendah dihitung nilai Root 

Mean Square Deviation (RMSD) dengan 

membandingkan antara konformasi yang 

memberikan doking score terendah dan 

konformasi awal dari molekul ligan asli 

pRD_00214 (ref_ligand) dengan bantuan 

program Yasara. Buka Yasara, 

loadref_ligand.mol2 dan file hasil 

docking yang dikopikan di 

C:/docking_plantske Yasara. Hapus 

atom hidrogen (Edit> Delete> 

Hydrogens) danhitung RMSD pose 

hasil docking dengan referensi hasil 

eksperimen /struktur kristal (Analyze> 

RMSDof> Molecules), muncul jendela 

“Select molecul esin first RMS Drange” 

dua kali. Pada muncul pertama pilih 

sequen ceatas, pada muncul kedua pilih 

sequence bawah. Sementara Name dan 

Belong stoorhas dibiarkan apa adanya. 

Lalu muncul jendela “Setpara meters”, 

pastikan semua opsi tidak diceklis, 

kecuali opsi“ molecule”. Akan muncul 

jendela command line di Yasara 

dibagian bawah menampakkan hasil 

kalkulasi RMSD (Purnomo,2013). 

Proses penambatan insiliko dinyatakan 

valid apabila diperoleh nilai Root Mean 

Square Deviation (RMSD)<2Å. 

Kantung ikatan yang memberikan hasil 

valid pada proses penambatan insiliko 

dapat digunakan untuk penambatan 

molekul senyawa seskui terpenlakton 

dari daun afrika (Vernonia amygdalina) 

secara insiliko (Purnomo, 2013). Nilai 

Root Mean Square Deviation 

(RMSD)<2Å biasanya digunakan 

sebagai kriteriake suksesan suatu 

metode Docking. Maka semakin kecil 

Nilai RMSD maka menunjukan bahwa 

poseligan yang diprediksi semakin baik, 

Karena semakin mendekati konformasi 

native (Jainand Nicholls, 2008). 

 

Proses penambatan In Silico Molekul 

Senyawa Sesquiterpen Lakton dari 

Daun Afrika(Vernonia amygdalina 

Del.) 

Molekul senyawa Sesquiterpen Lakton 

dari daun afrika (Vernonia amygdalina 

Del.) dibuat model dua dimensi (2D) 

dan konformasi tiga dimensinya dengan 

bantuan program Marvin Sketch. 

Konformasi tiga dimensi (3D) dari 

masing-masing molekul senyawa 

Sesquiterpen Lakton dari daun afrika 

(Vernonia amygdalina Del.) 
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ditambatkan kedalam kantung ikatan dengan 

bantuan program Plants, Cmd, Mingwm10, 

Pc_4pyp, Notepad, sehingga diperoleh 

docking score dari masing-masing konformasi 

dari molekul senyawa Steroid glikosida dari 

daun afrika (Vernonia amygdalina Del.) pada 

kantung ikatan. Konformasi dari suatu 

molekul senyawa Sesquiterpen Lakton dari 

daun afrika (Vernonia amygdalina Del.) yang 

memberikan docking score yang terendah 

pada kantung ikatan tertentu kemudian akan 

dibandingkan dengan konformasi molekul 

senyawa pembanding pada kantung ikatan 

yang sama (Purnomo, 2013). Prosedur diatas 

dilakukan untuk setiap satu ligan /senyawa 

(Pranowo, 2009). 

 

Visualisasi Hasil Docking 

Visualisasi hasil Docking dilakukan dengan 

menggunakan program Moe 2008. Program 

Moe 2008 digunakan untuk 

memvisualisasikan dalam bentuk dua dimensi 

(2D) dan tiga dimensi (3D), yaitu untuk 

melihat diinterprestasi interaksi yang terjadi. 

Buka aplikasi Moe 2008. Load file pdb> Klik 

SEQ>klik select>ligand. Pada baris kedua 

>klik select>pocket. Kemudian klik 

compute> ligan dinteraction>klik apply. 

Kemudian pada menu bagian bawah, 

klik report untuk mengetahui asam 

amino-asam amino dengan jelas dalam 

bentuk tiga dimensi (3D) (Lill dan 

Danielson, 2010). 

 

PEMBAHASAN 

Validasi Metode Penambatan In 

Silico 6LU7 

Enzim protease yang diperoleh dari 

protein Data Bank (PDB) dengan kode 

6LU7 merupakan gabungan antar 

molekul ligan asli PRD_002214 dengan 

molekul kantung ikatan enzim protease. 

Molekul ligan asli PRD_002214 

dipisahkan dari ikatannya dengan 

menggunakan bantuan program Yasara, 

sehingga akan diperoleh molekul ligan 

asli protease. Gambar berikut 

menunjukkan molekul kantung ikatan 

enzim protease dan molekul liganasli 

PRD_002214 dari enzim protease vitus 

SARS-Cov-2. 

 

 

 

 
     (A)     (B) 

Gambar 1 A. molekul kantung ikatan enzim protease 6LU7 virus SARS-Cov-2 

B. molekul ligan asli PRD_002214 dari enzim protease 6LU7 virus SARS-Cov-2 

Molekul ligan asli PRD_002214 dibuat mode 

ldua dimensi dan konfigurasi tiga dimensinya 

dengan menggunakan program Marvin 

Sketch. Hal ini dilakukan agar molekul ligan 

asli PRD_002214 lebih mudah untuk 

ditambatkan kembali pada molekul kantung 

ikatan asalnya, yaitu enzim protease. 

Penambatan kembali pada molekul ligan asli 

PRD_002214 kedalam molekul kantung 

ikatan enzim protease dilakukan dengan 

menggunakan bantuan program 

PLANTS, sehingga diperoleh Docking 

score dari masing-masing konformasi. 

Konformasi yang memberikan Docking 

score yang terendah dihitung nilai Root 

Mean Square Deviation (RMSD). 

Penghitungan dilakukan dengan 

membandingkan antara konformasi 

yang memberikan Docking score 

terendah pada konformasi awal dari 
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liganasli PRD_002214 dengan menggunakan 

bantuan Yasara. Sehingga dapat ditentukan 

bahwa molekul kantung ikatan enzim protease 

6LU7 virus SARS-Cov-2 pada proses 

penambatan secara In Silico dinyatakan valid 

atau tidak. Gambar 4.2 menunjukan 

proses penambatan kembali molekul 

ligan asli PRD_002214 kedalam protein 

Enzim protease 6LU7 virus SARS-Cov 

2.

 

 
  1 

   

  2 

 

Gambar 2 penambatan kembali molekul 

ligan asli PRD_002214 kedalm protein Enzim 

protease 6LU7 virus SARS-Cov-2 

a. Protein Enzim protease 6LU7 virus SARS-

Cov-2 

b. Molekul ligan asli PRD_002214 

Proses penambatan secara In Silico 

dinyatakan valid apabila diperoleh nilai Root 

Mean Square Deviation (RMSD) sebesar 

1,7812Ǻ. Hal ini menunjukkan bahwa proses 

penambatan secara In Silico yang dilakukan 

pada penelitian berhasil dilakukan dan dapat 

dinyatakan valid. Proses penambatan secara 

In Silico pada molekul kantung ikatan enzin 

mprotease 6LU7 dinyatakan valid karena 

diperoleh nilai Root Mean Square Deviation 

(RMSD)<2Ǻ. Yang berarti parameter 

metode penambatan molekul yang 

digunakan memenuhi syarat. Sehingga 

molekul kantung ikatan enzim protease 

6LU7 dapat digunakan untuk 

penambatan molekul senyawa lignin 

secara In Silico (Rastini, 2019). 

 

Gambar 3 menunjukan Nilai RMSD 

pada molekul kantung ikatan 6LU7 

setelah membandingkan antara 

konformasi yang memberikan docking 

score terendah dengan konformasi awal 

dari liganasli PDR_992214 dengan 

bantuan program Yasara.
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Gambar 3 Nilai RMSD pada molekul kantung ikatan enzim protease 6LU7  Virus SARS-

CoV-2. 

Penambatan In Silico molekul senyawa 

Sesquiterpen Lakton dari Daun Afrika 

(Vernonia Amigdalina Del) terhadap Enzim 

Protease 6LU7 virus SARS-CoV-2 

Molekul senyawa Sesquiterpen Lakton dan 

molekul senyawa pembading lopinavir dan 

remsidivir dibuat molekul dua dimensinya 

dan konformasi tiga dimensinya dengan 

program Marvin Sketch. Konformasi tiga 

dimensi dari masing-masing molekul senyawa 

uji lignan ditambahkan kedalam kantung 

ikatan enzim protease 6LU7 yang sudah 

divalidasi. Penambatan dilakukan dengan 

Program PLANTS, sehingga diperoleh 

docking score dari masing-masing konformasi 

dari molekul senyawa uji lignan pada kantung 

ikatan enzim protease 6LU7. Docking score 

yang diperoleh dapat memberikan informasi 

bahwa senyawa uji lignan dapat menghambat 

enzim protease 6LU7 atau tidak. Konformasi 

dari molekul senya wauji Sesqui terpen 

Lakton yang memberikan score yang 

terendah pada enzim protease 6LU7 

dibandingkan dengan konformasi 

molekul senyawa pembanding lopinavir 

dan remdesivir yang memiliki docking 

score yang terendah pada kantung 

ikatan yang sama. Hal ini dilakukan 

untuk melihat apakah senyawa 

Sesquiterpenme miliki Docking score 

yang lebih tinggi dari senyawa 

pembanding lopinavir dan remdesivir 

atau sebaliknya, senyawa Sesquter 

penlakton memiliki docking score yang 

lebih rendah dari senyawa pembanding 

lopinavir dan remdesivir. Table 4.1 

menunjukkan penambatan insilico 

molekul senyawa Sesquiterpen lakton 

dan molekul senyawa pembanding 

lopinavir danremdesivir pada 

enzimprotease 6LU7.

 

 

Tabel 2 Penambatan In Silico Molekul Senyawa Sesquiterpen Lakton Dan Molekul Senyawa 

Pembanding Lopinavir Dan Remdesivir Pada Enzim Protease 6LU7. 
No Nama Rumus Molekul Docking

Sco

re 

1 Vernodalin C19H20O7 74,7986 

2 Vernolide C19H2507 76,1758 

3 Vernolepin C15H16O5 64,0374 

4 Vernomenin C15H16O5 64,2615 

5 Vernomygdin C21H32O7 62,4313 

6 Vernodalol C20H26O9 82,2826 

7 Hydroxylvernolide C20H29O7 65,3275 

8 11,13-

Dihyroxyver

C20H22O7 74,5273 
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nodalin 

9 4,15-Dihyrovernodalin C19H22O7 73,6384 

10 1,2,2’,3’-

Tetrahydrove

rnodalin 

C19H24O7 75,8064 

11 1,2,3,15,11,13,2’,3’-

Hexahydrove

rdalin 

C19H28O7 63,4321 

12 1,2,3,15,11,13,2’3’-

Octahydrove

rnodalin 

C19H26O7 72,9631 

13 Lopinavir C37H48N4O5 -124,007 

14 Remdisivir C27H35N6O5P -122,344 

   

Penelitian ini berfokus pada protease utama 

dari SARS Cov-2, terutama pada PDBID 

6LU7, sebagai protein target potensial untuk 

pengobatan COVID-19. PDBID 6LU7 adalah 

protease utama (Mpro) dalam SARS Cov-2, 

yang telah disusun dan ditempatkan kembali 

dalam Protein Data Bank (PDB) dan dapat 

diakses oleh public sejak awal Februari 

(Liuetal, 2020), telah berhasil mengkristalkan 

protease utama (Mpro) protease seperti 

chymotrypsin (3CLpro) dari COVID-19, yang 

telah disusun dan diposisikan ulang diProtein 

Data Bank (PDB) dan dapat diakses oleh 

publik. Protease ini mewakili target potensial 

untuk menghambat replikasi Corona virus. 

Molekul senyawa pembanding yang 

digunakan sebagai pembanding pada uji 

aktivitas penghambatan senyawa Sesquterpen 

Lakton dari Daun Afrika (Vernonia 

Amigdalina Del) terhadap molekul enzim 

protease 6LU7 adalah lopinavir dan 

remdesivir. Menurut Tegardan Purnomo, 

2013, Docking score hasil penambatan secara 

In Silico merupakan afinitas ikatan antara 

senyawa uji dengan enzim protease. Semakin 

rendah docking score hasil penambatan secara 

In silico, maka semakin kuat pula interaksi 

antara molekul senyawa uji dan 

enzimprotease. Berdasarkan hasil uji 

penelitian, molekul senyawa uji Sesquiterpen 

Lakton memiliki docking score yang lebih 

tinggi dibandingkan molekul senyawa 

pembanding lovinavir dan remdesivir 

terhadap molekul enzim protease 6LU7. Hal 

ini berarti bahwa molekul senyawa uji 

Sesquiterpen lakton memiliki nilai interaksi 

yang lebih lemah dibandingkan molekul 

senyawa pembanding lopinavir dan 

remdesivir terhadap molekul enzim 

protease 6LU7. Senyawa uji yang 

memiliki docking score yang mendekati 

docking score senyawa pembanding 

berarti senyawa uji tersebut memiliki 

aktivitas yang mirip dengan aktivitas 

senyawa pembanding tersebut. Pada 

penelitian ini, hanya molekul senyawa 

uji Vernodalol, Vernolide, 

1,2,2,3Tetrahydrovernodalia yang 

memiliki docking score yang mendekati 

docking score senyawa pembanding 

lopinavir dan remdesivir. Hal ini berarti 

bahwa molekul senyawa uji Vernodalol, 

Vernolide, 1,2,2,3Tetrahydrovernodalia 

memiliki aktivitas anti covid yang sama 

dengan senyawa pembanding lopinavir 

dan remdesivir pada penghambatan 

enzim protease 6LU7. Sedangkan 

molekul senyawa uji (-) Vernodalin, 

Vernolepin, Vernomenin, 

Vernomygdin, 

Hydroxyvernolide,11,13dihydroxyvern

odalin,4,15dihydrovernodalin,1,2,11,13,

2’,3’hexahydrovernodalin,1,2,3,15,11,1

3,2’,3’-octahydrovernodalin memiliki 

docking score yang lebih tinggi 

dibandingkan dengan docking score 

senyawa pembanding lopinavir dan 

remdesivir. Hal ini berarti senyawa 

tersebut memiliki aktivitas ant icovid 

yang lebih rendah dibandingkan dengan 

senyawa pembanding lopinavir dan 

remdesivir pada penghambatan enzim 

protease 6LU7 (Nerdy, 2015). 

 

KESIMPULAN 
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Berdasarkan pembahasan dan hasil penelitian 

diatas maka diperoleh kesimpulan sebagai 

berikut: 

1. Proses penambatan enzim protease 6LU7 

Virus SARS-CoV-2 dinyatakan valid, 

sehingga dapat digunakan untuk 

penambatan molekul senyawa uji 

sesquiterpen lakton dari Daun Afrika 

(Vernonia Amigdalina Del)secara insilico. 

2. Senyawa uji sesquiterpen lakton dari Daun 

Afrika (Vernonia Amigdalina Del.) mampu 

menambat enzim protease 6LU7 Virus 

SARS-CoV-2. 

3. Hasil visualisasi docking terhadap 

beberapa residu asam amino yang saling 

berinteraksi diantaranya terdapat ikatan 

hydrogen. 
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